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Web Printer Manager Tool Requirements
To use the Web Printer Manager Tool (Web PMT), you must have the following software and
hardware:
Ÿ WIDE FORMAT PRINT SYSTEMS 8825, 8830, 8850, 8855, 510DP, 721P, or X2
TECH
Ÿ

AccXES Controller

Ÿ

For the 6030 WIDE FORMAT and 6050 WIDE FORMAT printers, which have their
own embedded controller, the AccXES Print Server is required to use the Web PMT.
(See the Configure Remote Printer page.)
Memory (RAM): Factory installed RAM varies from 64 MB to 192 MB depending upon
AccXES Controller model.
AccXES Controller with the integrated 10/100 BaseTX (Access to the Web PMT is not
supported over the 3003 XTP NIC, the serial port, or the parallel port.)
- Tower Controller 2.0 (UP8) for 8855
- Embedded Controller 2.0 (N5T/CNG) for 8830 and 8850
- Embedded Controller 3.0 (EV4) for 8825
- Standalone Controller for WIDE FORMAT PRINT SYSTEM X2 TECH (KLF)
- Standalone Controller for all printers when available (HFT)

Ÿ
Ÿ

Ÿ
Ÿ
Ÿ
Ÿ
Ÿ
Ÿ
Ÿ
Ÿ

Note that a 9GB or larger capacity hard drive is recommended to support the optional
Color Scan-to-Net and scan-to-print.
Optional Finishing Device (Folder)
Optional Adobe PostScript feature license to support PostScript printing
Optional Scan-to-Net feature license to support Scan-to-Net
Optional Scan-to-Print feature license
Desktop computer with Netscape Navigator 7.0 (or newer) or Microsoft Internet
Explorer 5.5 (or newer) installed.
Screen resolution required is 800x600, or higher.
A network connection based on the TCP/IP protocol
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Web PMT Overview
As part of the AccXES firmware, the Web Printer Manager Tool (Web PMT) is accessed from
your workstation using the Netscape 7.0 (or newer) or Internet Explorer 5.5 (or newer) web
browser. To access the Web PMT, you need to enter the IP address of your printer in the
URL box of your browser ("Address" in Explorer or "Location" in Netscape) and press
ENTER.
The Web PMT enables three major functions:
Ÿ Provides print job management and status tracking
Ÿ Provides control over the printer’s default settings
Ÿ Provides a method to enable job accounting for printing, copying and scanning media
usage data to be saved in the AccXES Controller’s job log file. The data is retrieved
via an External Account Server, such as the Account Management Tool (AMT).
Note that this tool does not manipulate any Network Operating System print queues, such as
UNIX lpr/lpd queues, or Novell print queues.

Security
Any user can view Web PMT pages. The printer password is required to make any changes.

Main Menu
The Main Menu contains five selections in hypertext form allowing you to jump to other web
pages. These selections are:
SESSION SETUP
PRINTER DEFAULTS ACCOUNTING HELP
ABOUT

SESSION SETUP
Click on the SESSION SETUP link. This page is used to enter the printer password
for the current printer session. If the entered password matches the printer’s
password, you can access the full functionality of the Web PMT.

PRINTER DEFAULTS
Click on the PRINTER DEFAULTS link and the top page of the Printer Defaults pages
will be displayed. The Printer Defaults pages are organized into a number of groups
and subgroups. The top page of the Printer Defaults pages is the Configuration
subgroup of the UTILITIES group. This page is used to view the current configuration
data and go to the other Printer Defaults pages.
The Side Menu is used to access the various other Printer Defaults pages. Clicking
on a Side Menu group or subgroup will display the page appropriate to the menu
selection. You can only make changes to these pages if you entered the printer
password from the Session Setup selection.
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ACCOUNTING
Click on the ACCOUNTING link and the Accounting page will display. The Accounting
page is used to view the current status of Job Accounting. It can also be used by the
System Administrator to set the job logging capability of the printer's Controller, when
necessary, to "Enabled," "Disabled," or "Optional."

HELP
If you installed the help files on the AccXES Controller’s hard disk, you can click on
the HELP menu and on-line help for the current Web PMT page will be displayed in a
separate browser window. The on-line help contains links to main topics and an index
so that you can get help on any of the Web PMT pages.

ABOUT
Click on the ABOUT menu to display the About page, which contains information
about the current version of the Web PMT application, the version of firmware
installed in the AccXES Controller, and copyright notification.

Side Menu
A Side Menu with one or more groups may appear on the left side of the page. When you
click on a specific group item, a subgroup menu may appear, and the page associated with
the first subgroup will be displayed. Each of these group or subgroup pages will contain a
Main Menu header and a Side Menu below the header.
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Printer Defaults Pages
Group
UTILITIES

Subgroups (if any)
Configuration
Feature Configuration
Upload File
Change Password
Configure Remote Printer (6030/6050
printers only)
Reset Printer Defaults

Reset Error Log (X2 printer only)
Web PMT Settings
Install Help Files
PORTS
NETWORK

TCP/IP (EtherTalk, NetBEUI, IPX/SPX
also shown with optional 10 Base T
Ethernet NIC)

PRINTER SETUP

Miscellaneous
Pen Palettes
Pen Patterns
Plot Labels
Fonts
Stamps
Date / Time
Power Saver (8855 Printer only)

EMULATIONS

HPGL
CalComp 906/907
Versatec Raster
VDS
CGM
VCGL
TIFF
PostScript

PROCESSING
DEFAULTS

Finishing
Justification
Margins
Media
Transform
Rendering

TEST PRINT

The Web Printer Manager Tool User Guide is a printout of the Web PMT Help Files.

Page 10

Web Print Manager Tool User Guide

Quick Start
Starting the Web PMT
When accessing the Web PMT, you must have a working connection between your computer
and the printer’s AccXES Controller. To access the Web PMT perform the following steps:
1. Start your Web browser. If your browser starts up in the Mail or News mode, go to the
Browser mode.
2. To access the Web PMT, set your browser so that it will not try to access the AccXES
Controller through a proxy server. To deselect a proxy connection within your browser,
perform the following steps.
Deselecting a Proxy In Netscape
Ÿ Select Preferences from the Edit menu.
Ÿ Click on the drop arrow next to the Advanced item and click on Proxies.
Ÿ In the Proxies dialog, select Direct connection to the Internet.
Ÿ Click OK
Deselecting a Proxy in Internet Explorer
Ÿ Select Internet Options from one of the toolbar menus.
Ÿ Click on the Connection tab > LAN Settings.
Ÿ Deselect the Access the Internet using a proxy server check box.
Ÿ For further instructions, see your Network Administrator.
3. In the browser URL box enter http:// followed by the printer’s IP address, (for example,
http://13.1.104.62). If you don’t know the printer’s IP address, see your System
Administrator or the test print set produced at the time of your printer’s installation.
When the power is switched on, the controller also sends a test print to the printer.
4. Configure Remote Printer Page (6030/6050 WIDE FORMAT printers only)
Ÿ Select PRINTER DEFAULTS > UTILITIES > Configure Remote Printer
Ÿ

Put in the IP address of the remote printer, and the job queue name of that printer,
where AccXES will send the print job data. The remote job queue is in the plt (0099) format, with an extension letter of t, c, h, b, or l. Your choices will show on the
screen, for example: (plt00.c).
5. Press the Update Remote Printer button to set your choices.
6. Select Printer Defaults > Network > TCP/IP. Check that the Subnet Mask, IP
Address, and Gateway settings are correct. These are needed so that your
workstation will be able to communicate with your AccXES compliant scanner and
printer.
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Job Queue and Media Status
1. Select BACK TO MAIN.
When you first access the Web PMT, or click on the BACK TO MAIN link, the Web
PMT will query the Printer’s AccXES Controller. It will report the currently installed
media status and the status of submitted print jobs on the Main Page. The status is not
automatically updated.
Media status
The Media Status table reports the status of the rolls in the printer. This includes
media size and the status of the material remaining on the roll. If a folder is attached to
the printer, the Finishing table will display the folder Type and Status.
Job Queue
The Job Queue will refresh automatically, based on the timeout that is set from the
UTILITIES > Web PMT Settings page.
The Job Queue List displays the Job Queue inside the AccXES Controller. The list
contains information about all submitted print jobs from all sources currently queued in
the AccXES Controller’s internal spool queue. In the Port column, if the job was
received over the network, the host IP Address will be displayed. For copy, scan-toprint, and scan-to-print jobs, “Scanner” will be displayed.
2. To view only the active print jobs (i.e., not list the canceled or completed jobs), check
the Show Active Jobs Only box and press the Get Status button.
3. For any mismatched job, indicated in the Status column of the Job Queue, click on the
supplied checkbox to obtain information about the mismatch condition. Mismatch jobs
can occur when there is an incorrect media type or size in the printer for the type of
image being printed.

Viewing the Printer Configuration and Printing a Test
Print
1. Click on PRINTER DEFAULTS and the Configuration page of the UTILITIES group
will display. This read-only page displays system configuration parameters for the
printer.
2. To print out the system configuration data and other printer default settings, click on
the TEST PRINT item on the Side Menu.
3. When the Test Print page displays, press the Minimal, Normal, or Full button to
select the type of test print. The test print will be given the highest priority and will be
sent to the printer. If you purchased and installed the PostScript option, you can also
press the PostScript button to print a PostScript test page.
NOTE: The "Minimal " selection prints just the Printer Configuration Test Print, which
includes, among its configuration, feature key licensing information, the IP Address,
Subnet Mask, and Gateway address for your printer.
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Entering the Printer Password
NOTE: If you do not need write-access to the printer default settings, you do not need to
enter a password for your current Web PMT session. If you wish to change any of the printer
settings, however, you MUST enter the printer’s password from the Session Setup link on the
Main Menu. The default password is the number 0. If you change the password, write it
down to remember it.
1. Click on SESSION SETUP on the Main Menu.
2. When the Session Setup (Password) page displays, enter the printer password in the
designated field (a number in the range 0 to 65535). For security reasons, the asterisk
character appears for each password digit.
3. Press the Submit button. If the entered password matches the correct system
password, you have write-access to the printer settings. The AccXES Controller will
send back a message stating either “Password verification passed” or “Password
verification failed.” See your System Administrator for the appropriate password, when
needed.

Printer Language
1. Click on PRINTER DEFAULTS > PRINTER SETUP > Miscellaneous > Printer
Language.
2. Click on the Printer Language list box to select the language used by the system
displays and Test Print pages.
3. Press the Update Printer button.

Install Help Files
1. Click on PRINTER DEFAULTS > UTILITIES > Install Help Files and the Install Help
Files page will display. If you entered the printer password, from the Session Setup
link on the Main Menu, and the AccXES Controller has a hard disk, yo u can use this
page to upload the Web PMT help files to the hard disk.
2. Enter the name of the help file in the indicated text field (example wenglish.hlp). The
help file is supplied in packed form on the Web PMT CD-ROM. As an aid in finding this
file, press the Browse... button to display the standard file dialog. The help file can
also be downloaded from the xerox.com website, Support & Downloads section, but
you may need to select the proxy server to access the Internet.
3. Press the Install button to install the help files on the hard disk. The AccXES
Controller will send back a message stating that the "File Uploaded Successfully".
4. Press the hyperlink or Back arrow button to return to the last Web PMT page.
On any Web PMT page, you can now select the HELP to access additional help.
To view this tutorial electronically, select Help > Index > Quick Start.
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Uploading a File
1. Click on Printer Defaults > Utilities > Upload File .
2. In the Select the file to upload field, enter the filename (with extension) and its
location. To view the standard Open File dialog, press the Browse button.
3. Press the Upload button to transfer the file to the system AccXES Controller. A
message page will display stating the success or failure of the request. The file will
print out.

Canceling a Print Job
1. Send a few print jobs to the printer by doing one of the following:
Ÿ Send a test print (Printer Defaults > Test Print > Normal Test).

2.
3.
4.
5.
6.

Ÿ Upload a file.
Ÿ Scan images.
Select BACK to MAIN.
Press the Get Status button to update the Job Queue List.
Click on an active print Job Name (the name is a hypertext link) and the Selected Print
Job page will display.
Press the Cancel button to cancel this print job. The Canceled Print Job page will
display, showing that the job was canceled, or is in the process of being canceled.
Press the OK button or the BACK TO MAIN link to return to the Main Page.
For any mismatched job, indicated in the Status column of the Job Queue, click on the
supplied checkbox to obtain information about the mismatch condition. The printer
password is not required.
NOTE: In the AccXES Client Tools, to cancel a submitted job, highlight the job name
in the Printer Queue window. Select the Cancel toolbar button.

Set Display Units Page
If you entered the printer password, from the Session Setup link on the Main Menu, you can
set the units of measure for the Web PMT pages by doing the following:
1. Click on PRINTER DEFAULTS > UTILITIES > Set Display Units to go to the Set
Display Units page.
2. Click on the appropriate radio button, mm/cm (millimeters/centimeters) or in. (inches),
to select the display units.
3. Press the Update Printer button to set the selected units in the printer. A message will
be displayed which will state the success or failure of the request.

Setting the Accounting Mode
1. Click on ACCOUNTING and the Accounting page will display.
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2. To set the Accounting Mode, click on the Disabled, Enabled, or Optional radio
button.
When Disabled is selected, a valid User and Account ID will not be needed to scan
images, or to print to the printer.
When Enabled is selected, a valid User and Account ID will be required to print to
the printer. Failure to supply valid IDs at the scanner, will result in an "Invalid ID"
message at the scanner.
When sending images from the Document Submit Tool, using invalid IDs will result in
the printing of an Error Page.
When Optional is selected, a User ID and Account ID will not be required to scan or
to print to the printer. If the scan or print job contains valid IDs, however, the Media
Usage data will be logged in the AccXES Controller's Job Log File for the User and
Account specified.
3. Press the Update Printer button to set the Accounting Mode. The AccXES Controller
will send a message back indicating the success or failure of your request.
NOTE: Effective with Firmware 7.0, User IDs and Account IDs are created with the
AccXES Account Management Tool running on a networked client workstation. For
more information, refer to the AccXES Account Management Tool Administrator's
Guide.

Adding a Label
1. Click on PRINTER DEFAULTS > PRINTER SETUP > Plot Labels.
2. Click on Help near the top of your screen for details.

Uploading a Stamp to the Printer
1. Click on PRINTER DEFAULTS > PRINTER SETUP > Stamps.
2. Click on Help near the top of your screen for details.

Mismatch Queue
1. Select PRINTER DEFAULTS > PROCESSING DEFAULTS > Media to display the
Media page.
2. Enabled Checkbox - Click on this check box to enable/disable mismatch queuing.
When a media mismatch occurs, and this box is not checked, the Status column of the
Job Queue List will display Mismatch/Blocked, and printing will pause until the
necessary medium is installed or the job is cancelled. When a media mismatch occurs,
and this box is checked, the Status column of the Job Queue list will display
Mismatch/Queued. In this case, pages requiring the missing medium are not printed,
but pages requiring media which are currently installed will be printed.
3. Press the Update Printer button.
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Media Mismatch Mode
1. Select PRINTER DEFAULTS > PROCESSING DEFAULTS > Media to display the
Media page.
2. Click on the Media Specific Settings list box to select a media type.
3. Press the Adjust Settings (Text Form), or Adjust Settings (Graphical UI) button to
go to the Media Specific Settings page.
4. Media Mismatch Mode - Select the QUERY mode if yo u want the printer to prompt
the operator at the printer control panel to install the appropriate media size. Select the
SUBSTITUTE mode if you want the printer to make media substitutions as necessary
to print the page. Select the SCALING mode if you want the printer to automatically
scale to the nearest available media size of the same media type.
NOTE: SUBSTITUTE is not a listed selection for the color printers because the
selected media is a key component of color print quality.
5. Select the Update Printer button.

Selecting Color Parameters
Color Settings and Processing Defaults are made on the Media Page and the Rendering
Page as follows:

Media Page
1. Select PRINTER DEFAULTS > PROCESSING DEFAULTS > Media to display the
Media page.
2. Click on the Media Specific Settings list box to select a media type.
3. If you have a Java plug-in installed
(http://java.sun.com/products/archive/j2se/1.4.0/index.html), or if you have permissions
to install it for your browser, then select the Adjust Settings (Graphical UI) button. If
not, press the Adjust Settings (Text Form) button.
4. Make Cyan, Magenta, Yellow, and Black color ink selections to set up the ink limit and
output gamma that will be applied to the image.
Ink Limit is used to change the maximum amount of ink used in printing.
Gamma is used to adjust the entire color curve without moving the endpoints of the
curve. This adjusts the mid-tones (higher gamma produces darker mid tones), with
minimal effect on shadows and highlights.
See the Media Specific Settings section of the Media Page help file for details.
5. Press the Update Printer button.

Rendering Page
1. Select PRINTER DEFAULTS > PROCESSING DEFAULTS > Rendering to display
the Rendering page.
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2. Render Mode - Click on this list box to set the Render Mode for color printers to color
or grayscale. For monochrome printers, grayscale is the only valid option. Color is the
X2 TECH’s factory default setting, however if Render Mode is set to Grayscale, color
jobs will be rendered in appropriate grayscales.
3. Select Help near the top of your screen for details on other Rendering choices.
4. Press the Update Printer button.
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SCANNING YOUR IMAGES/DOCUMENTS
A Color feature key is optionally available, enabling color scans in TIFF and JPEG
formats.
Ÿ At the scanner, press the Mode button to select "Scan mode".
Ÿ For firmware 7.0 or greater, put in the Scan Directory name.
Ÿ For firmware 9.1 or greater, pressing the Sample Mode button while in the “Ready
to Scan” screen, will bring up a menu to select “scan-to-file”, “scan-to-print”, or
both.

Ÿ

NOTE: If you disable both checkboxes, then you cannot exit the screen until at
least one box is checked.
The Image Quality area of the Scanner Control Panel allows you to make corrective
adjustments to the image and extract the best possible copy quality from an original
document. Select Photo & Normal if the document contains a mixture of photographic
and line images, color, or halftone images. In the Scanner screen, select the Next
button > Format > Enter button > JPEG or TIFF >Enter button > Exit button.

Printer Resident GL/2 Fonts
Select PRINTER DEFAULTS > PRINTER SETUP > Fonts.

Paper and Roll Sizes
Select PRINTER DEFAULTS > PROCESSING DEFAULTS > Media >Media Size
and Media Type drop down menus.

AccXES Controller Supported File Formats
Select PRINTER DEFAULTS > EMULATIONS. The file types are listed in the side
menu.

Other Features
Ÿ

Select HELP > Index.

Ÿ Double click on a topic.
THIS ENDS THE QUICK START.
The rest of these pages/files are copies of the individual Help files.
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Main Page and Printer Job Queue
Navigation: BACK TO MAIN
The Main Page contains the Title line and the following areas:
Ÿ The Main Menu (hypertext links to printer settings)
Ÿ The Printer Status area containing two status li nes with a Show Active Jobs Only
checkbox and a Get Status button, a Media table and a Finishing table
Ÿ The Job Queue List

Main Menu
The SESSION SETUP, PRINTER DEFAULTS and ACCOUNTING links are used to access
the other Web PMT pages. A BACK TO MAIN link will appear on the title line on each page
these access. The Side Menu corresponding to the linked page will be displayed just below
the Main Menu and on the left side of the page.
Click on the HELP link and online help for the current page on the Web PMT will be displayed
in a separate browser window. Click on the ABOUT link to display the standard About Box.

Printer Status
To get the current printer status and Job Queue List:
1. Click on the Show Active Jobs Only box (place a check mark) to view the active print
jobs (i.e., do not list the canceled or completed jobs).
2. Press the Get Status button to update the printer status (including the Media and
Finishing status) and the Job Queue List.

Job Queue List
The Job Queue will refresh automatically, based on the timeout which is set from the
UTILITIES > Web PMT Settings page.
The Job Queue List contains information about all jobs from all sources currently queued in
the printer's internal spool queue, one row per job. Red text indicates that the job has been
canceled or that an active job has a Status of Mismatch. All other jobs are displayed in black
text.
The Job Name of an active (i.e., not canceled or completed) job in the Job Queue List is a
hypertext link. Click on the Job Name link to display the Selected Print Job Page. When this
page is displayed, you can cancel or change the priority of the selected print job if you
entered the printer password in the Session Setup.
NOTE: The AccXES firmware supports a maximum of 128 active jobs in the print queue. If
subsequent jobs are sent before the 128th job prints, the job will be refused, which results in a
scan error.
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Selected Print Job Page
Navigation: BACK TO MAIN > Active Job Name link
If you entered the printer password in the Session Setup, you can cancel a print job or
change its priority.
1. To cancel the selected print job, press the Cancel button. The Canceled Print Job
page will display, showing the success or failure of the request. Press the OK button
on the Canceled Print Job page to return to the Main Page.
2. To change the priority of the selected print job, click on the Priority list box to select a
new priority. You can select a priority value from 1 to 10, with 10 being the highest
priority. Next, press the Change Priority button to change the priority to the value
displayed in the Priority list box. The Changed Priority Print Job page will display,
showing the success or failure of the request.
3. Press the OK button to return to the Main Page from the Changed Priority Print Job
page.
If you do not want to make any changes, click on the BACK TO MAIN link to return to the
Main Page.
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Test Print Page
Navigation: PRINTER DEFAULTS > TEST PRINT
Use this page to test the printer, print a PostScript test page and print the printer's
configuration, settings and Pen Palettes. Four types of test prints are available:
1. Press the Minimal button to print the printer's configuration data.
2. Press the Normal button to print the printer's configuration and settings information.
3. Press the Full button to print the printer's configuration, settings and pen palettes
information.
4. Press the PostScript button to print a PostScript test page (a PostScript license is
required).
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Session Setup (Password) Page
Navigation:

SESSION SETUP

You do not need to enter a password to view the job queue or the printer settings, or to
generate a test print or an account ID report. If you need to change the printer default
settings, manipulate accounts or manage the printer job queue, do the following:
1. Enter the printer password in the designated field (a number in the range 0 to 65535).
For security reasons, the asterisk character appears for each password digit.
2. Press the Submit button. If the entered password matches the password in the printer,
you have write -access to the printer settings. The printer will send back a message
stating either "Password verification passed" or "Password verification failed".
3. To exit this page, click on the BACK TO MAIN link or a Main Menu link.
NOTE: The result of entering a password that does not match the printer password is the
same as not entering a password.
To change the password in the printer, you must first enter the current printer password on
the Session Setup page and then go to the Change Password page of the UTILITIES group
in the Printer Defaults pages.
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Utilities Menu
Configuration Page
Navigation: PRINTER DEFAULTS > UTILITIES > Configuration
This read-only page displays key system configuration data (the hardware, software, and
version numbers present on the Xerox Corporation printer).
Key Install Key (KIK) - The customer will be asked for this unique number when the
Feature Coupon is redeemed to install feature key licenses. This number is also
needed if a feature key has to be reinstalled, or if an installed feature key needs to be
uninstalled to move it to another printer. A new KIK number is generated each time
the AccXES Controller is rebooted.

Feature Configuration Page
Navigation: PRINTER DEFAULTS > UTILITIES > Feature Configuration
The AccXES firmware feature key licenses are listed in the AccXES Features section. If it is
a temporary license, the word "temporary" will show in the Installed column and the amount
left on the license will show in the Notes column. If the license is not installed, “Not Present”
will show. For each feature that is “Present”, the State column will say if it is “Enabled” or
“Disabled” for use.
For a Synergix scanner, the Scanner Features section lists speed and color enablement
feature keys.
For the WIDE FORMAT PRINT SYSTEM 510DP, a Printer Features section lists the feature
keys of 7D (prints/minute speed),10D (5 is standard), drawer 2, and drawer 3.

Upload File Page
Navigation: PRINTER DEFAULTS > UTILITIES > Upload File
If you entered the printer password in the Session Setup and the printer has a hard disk
drive, you can transfer a file from your file system to the printer. Files can be of any type
supported by the printer; including AccXES Controller, scanner and IOT firmware uploads.
To upload a file:
1. Enter the filename (with extension) and its location in the text field. To help select a
file, press the Browse... button to display the standard file dialog.
2. Press the Upload button to transfer the file to the printer. During firmware uploads the
Web PMT will not function.
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Change Password Page
Navigation:

PRINTER DEFAULTS > UTILITIES > Change Password

If you entered the printer password in the Session Setup, then to change the printer
password:
1. Enter the current printer password in the first (top) text field.
2. Enter the new printer password in both the middle and bottom text fields (a number in
the range from 0 to 65535).
3. Press the Update Printer button to send the current and new passwords to the printer.
Note that if you set the printer password to 0, the printer will no longer be password protected
and any user of the Web PMT can change the printer default parameters (including the
printer password), cancel jobs, or change the priority of jobs without restriction.
For security reasons, the asterisk character appears for each password digit. A message will
be displayed which will state the success or failure of the request to change the printer
password. If the printer accepts the change to its password, you will continue to have writeaccess (you do not need to re-enter the printer password for the current Web PMT session).

Configure Remote Printer Page (6030/6050 printers only)
1. Put in the IP address of the remote printer, and the job queue name of that printer, where
AccXES will send the print job data. The remote job queue is in the plt (00-99) format,
with an extension letter of t, c, h, b, or l. Your choices will show on the screen, for
example: (plt00.c).
2. Press the Update Remote Printer button to set your choices.
3. As part of the AccXES firmware, the Web Printer Manager Tool (Web PMT) is accessed
from your workstation using the Netscape 7.0 (or newer) or Internet Explorer 5.5 (or
newer) web browser. To access the Web PMT you need to enter the IP address of your
printer in the URL box of your browser ("Address" in Explorer or "Location" in Netscape)
and press ENTER.
The following are Status Messages that might be displayed on the Configure Remote Printer
Page.
Status Message
Attempting to communicate with this printer.
This page will refresh until the process completes.
followed by:
Contacting the remote printer, please wait...
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Reason/Circumstances
Initiating a session to update the remote
IP/Queue.

Communication with the printer was successful.

If the effort to contact the remote printer
was successful.

The printer link is up.
The attempt to contact the printer has failed.

Remote printer time out.

The printer link is down.
The printer is currently being used by another user.

Attempting to change the IP when another
WebPMT session is active.

Please try later.
The remote printer ethernet address is invalid.

Submitting an invalid IP#.

The remote printer queue number is invalid.

Submitting an invalid queue number.

Your session has been cancelled.

Cancelling the remote session.

Reset Printer Defaults Page
Navigation: PRINTER DEFAULTS > UTILITIES > Reset Printer Defaults
Ÿ

If you entered the printer password in the Session Setup, you can press the Reset
button to reset the printer settings to the factory default settings.

Reset Error Log Page (X2 TECH only)
Navigation: PRINTER DEFAULTS > UTILITIES > Reset Error Log
Ÿ

If you entered the printer password in the Session Setup, you can press the Reset
button to reset the printers error log.
NOTE: After resetting the error log, all entries will be lost.

Web PMT Settings Page
Navigation: PRINTER DEFAULTS > UTILITIES > Web PMT Settings Page
If you entered the printer password in the Session Setup, then to set the units of measure for
the Web PMT pages:
1. Display all appropriate units in - Click on the appropriate radio button, either
mm/cm (millimeters/centimeters) or in. (inches), to select the display units. This will
display the units as selected on all appropriate WebPMT pages.
2. Main Page refresh timeout - This setting is used to refresh the Main Page. The Main
Page will be refreshed the chosen number of seconds.
3. Press the Update Printer button to update the specified parameter changes in the
printer.
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Install Help Files Page
Navigation: PRINTER DEFAULTS > UTILITIES > Install Help Files
1. Enter the name of the help file in the indicated text field. The help file is supplied in
packed form on the Web PMT CD-ROM (see note below). As an aid in finding this file,
press the Browse... button to display the standard file dialog.
2. Press the Install button to install the help files on the printer hard disk.
NOTE: The help file can also be downloaded from the xerox.com website, but you may
need to select the proxy server to access the Internet:
o Go to http://www.xerox.com.
o Choose Support & Drivers.
o Go to the Wide Format section.
o Select the hyperlink that refers to “AccXES 88xx/ X2-Tech/ 510/ 721P”.
o In the Utilities & Applications section, choose the “Web PMT Help Files ”. Save the zip
file to your PC.
o Open the downloaded .zip file and extract the wenglish.hlp file.
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Ports Menu
Navigation: PRINTER DEFAULTS > PORTS
If you entered the printer password in the Session Setup, you can change the following
parameters of the non-networked host communication ports and the Host Port Timeout.
1. Host Port Timeout - This timeout value applies to the Controller’s centronics
(parallel), and serial ports. If there is a pause in the incoming data stream over one of
these ports, for the period of time specified here as the "timeout" value, the incoming
plot data will be considered complete. Subsequent incoming data will begin a new plot.
Valid values range from 5 to 300 seconds, with a factory default of 5 seconds.
2. VPI timeout enabled - Selecting this option (by placing a checkmark in the box),
causes the Host Port Timeout to also apply to the VPI port, if present on your AccXES
Controller. If not selected (with the box not checked), then the VPI port will not time out
while waiting for plot data.
3. SCSI
Ÿ SCSI Port ID - Click on this list box to select the value of the host interface target
SCSI ID. The range of possible values is from 0 to 7.
Ÿ SCSI Bus Termination - If the printer is the last device on the SCSI bus, click on
this list box and select Enabled. This will enable SCSI bus termination within the
printer.
4. Serial Port
Ÿ
Ÿ

Ÿ

Baud Rate - Click on this list box to select the baud rate on the printer's serial port.
The possible values are 300, 600, 1200, 2400, 4800, 9600 and 19200.
Flow Control - Click on this list box to set the flow control to NONE, XON/XOFF,
RTS/CTS, or BOTH. RTS/CTS corresponds to hardware control and XON/XOFF to
software control.
Parity - Click on this list box to set the parity to EVEN, ODD or NONE.

5. Press the Update Printer button to update the requested parameter changes in the
printer.
NOTE: Changes made here only change the serial port settings on the printer (and not your
computer).
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Network Menu
EtherTalk Page (8830/8825 only)
Navigation: PRINTER DEFAULTS > NETWORK > EtherTalk
If you entered the printer password in the Session Setup, you can change the following
EtherTalk parameters in the printer:
1. Enabled - Click on this check box to enable/disable EtherTalk on the printer.
2. EtherTalk Zone - Enter the AppleTalk zone name (up to 31 characters) upon which the
printer operates in this text box. Enter * (asterisk) to use the EtherTalk router's default
zone.
3. EtherTalk Phase - Click on the Phase 1 or Phase 2 radio button to select the EtherTalk
phase.
4. AppleTalk Printer Name - Enter the printer name (up to 31 characters) for the AppleTalk
protocols in this text box.
5. Press the Update Printer button to send the requested parameter changes to the printer.
Note that if the Enabled box is not checked, the parameters will be updated but EtherTalk
will remain inactive on the printer.

NetBEUI Page (8830/8825 only)
Navigation: PRINTER DEFAULTS > NETWORK > NetBEUI
If you entered the printer password in the Session Setup, you can change the following
NetBEUI parameters in the printer:
1. Enabled - Click on this check box to enable/disable NetBEUI on the printer. When
checked, NetBEUI is enabled.
2. NetBEUI Group - Enter the group name (up to 15 characters) of the printer in this text
field.
3. NetBEUI Machine Name - The field displays the NetBEUI Machine Name for the printer.
This is a read-only field.
4. NetBEUI Remark - In this text box, enter the Remark string (up to 47 characters) for the
NetBEUI protocol. This field is used to identify the printer with a name that is recognizable
on your network.
5. Press the Update Printer button to send the requested parameter changes to the printer.
Note that if the Enabled box is not checked, the parameters will be updated but NetBEUI
will remain inactive on the printer.
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6. The NetBEUI Machine Name field displays the NetBEUI Machine Name for the printer.
This is a read-only field.

TCP/IP
Navigation: PRINTER DEFAULTS > NETWORK > TCP/IP
You can use this page to view and change the TCP/IP communication parameters of the
printer’s AccXES Controller. To change settings, you will have to enter the printer password
from the Session Setup link on the Main Menu.
TCP/IP parameters on the WIDE FORMAT PRINT SYSTEMS 8830 /8825 /8850 /510DP are
read-only through the Web PMT and thus, can only be modified at the printer control panel.
On the WIDE FORMAT PRINT SYSTEMS 8855 and 721P, the TCP/IP parameters can be
modified by users with printer password.
However, incorrect specification of the TCP/IP parameters can result in the Web PMT
losing all communication with the printer.
1. DHCP enable - When this box is checked (enabled), the network interface utilizes the
Dynamic Host Configuration Protocol to acquire a temporary IP Address for the
networked device from a client that is supplying DHCP services on the network. As
constantly changing (temporary) IP addressing can cause problems for users in network
communications, the default value for this feature is "not checked" (disabled).
WARNING - If this box is checked and there is no DHCP server on the network, the
Web PMT will be completely unusable. For the WIDE FORMAT PRINT SYSTEM
8825, 8830, 8850, and 510DP you can use the Printer Control Panel to undo this
setting. For the WIDE FORMAT PRINT SYSTEM 8855 and 721P, you will need to
upload a recovery file to the AccXES Controller through the serial or parallel port.
2. RARP/BOOTP enable - When this box is checked (enabled), the network interface
utilizes the RARP and BOOTP protocols to acquire an IP Address from the appropriate
server. Since the AccXES Controller should have been assigned a fixed IP Address by
the Systems Administrator, it should not be necessary for the Controller to have to query
the network to discover its IP Address. The default setting for this feature, therefore, is
"not checked" (disabled).
WARNING - If this box is checked and there is no RARP server on the network, the
Web PMT will be completely unusable. For the WIDE FORMAT PRINT SYSTEM,
8830, 8850 and 510DP, you can use the Printer Control Panel to undo this setting.
For the WIDE FORMAT PRINT SYSTEMS 8855 and 721P, you will need to upload a
recovery file to the AccXES Controller through the serial or parallel port.
3. Netmask - These fields contain the value that the printer will use for its IP sub-net mask.
The format is the same as the Ethernet TCP/IP Address.
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4. Ethernet TCP/IP Address - These four fields contain the IP address of the Network
Interface Card on the printer’s AccXES Controller. The address is of the form "w.x.y.z"
where the range for w, x, and y is 0-255 and z is 0-254.
5. Ethernet TCP/IP Gateway - These fields contain the IP address of the device the printer
will use as the gateway or router. The format is the same as the Ethernet TCP/IP
Address.
For the WIDE FORMAT PRINT SYSTEMS 8855, 721P, and X2 TECH, BEFORE pressing
the Update Printer button, click on the indicated hypertext link to save a TCP/IP Recovery
file. If the Web PMT becomes unusable, you can send this recovery file to the AccXES
Controller through the serial or parallel port. For the WIDE FORMAT PRINT SYSTEMS
8825/8830/8850/ 510DP Printers, you MUST make a written record of these settings
BEFORE clicking the Update Printer button.
NOTE: After modifying the IP Address, Subnet Mask, or Gateway, you should reboot (power
off, then power on) the AccXES Controller to use the new settings.

IPX/SPX Page (8830/8825 only)
Navigation: PRINTER DEFAULTS > NETWORK > IPX/SPX
If you entered the printer password in the Session Setup, you can change the Novell
IPX/SPX parameters in the printer if you have the network interface card. These parameters
are described below:
1. Enabled - Click on this check box to enable/disable IPX/NDS on the printer.
2. IPX Frame Type - Click on this list box to select the IPX frame (link level) protocol.
The possible values are AUTO, 802.3, 802.2, SNAP and ETHERNET2.
3. IPX Queue Scan Rate - Enter the query interval in integer seconds (0-255). This
controls the frequency with which NetWare file servers are queried for print jobs.
4. Bindery Mode (Novell 3.XX) - Click on this radio button to enable the Bindery Mode;
the NDS Mode will be disabled.
IPX Primary Server - Enter the name (up to 47 characters) of a preferred server (in a
Novell network). This server should hold the Novell network configuration file for the
Network Interface Card (NIC), and will be the first server searched when the NIC boots
up with the printer. If this field is blank, all servers will be searched.
NOTE: This field cannot be blank if the Bindery Mode is currently being used. On
power-up, the NIC will search the network for the primary server that contains the
configuration file that identifies all the available print servers. This text box will be
ignored if the NDS Mode radio button is selected (see below).
5. NDS Mode (Novell 4.XX) - Click on this radio button to enable the NDS Mode; the
Bindery Mode will be disabled. The NDS Mode text boxes will be ignored if the NDS
Mode radio button has not been selected.
Ÿ IPX NDS Tree - Enter the name (up to 63 characters) of the NDS Tree to which the
NIC connects.
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Ÿ

IPX Context Name - Enter the name (up to 126 characters) of the NDS context
(location) of the printer.
6. Press the Update Printer button to send the requested parameter changes to the
printer. Note that if the Enabled box is not checked, the parameters will be updated but
IPX/SPX will remain inactive on the printer.
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Printer Setup Menus
Miscellaneous Page
Navigation: PRINTER DEFAULTS > PRINTER SETUP > Miscellaneous
If you entered the printer password in the Session Setup, you can change the following
Miscellaneous parameters in the printer:
1. Toner Density - Click on this list box to select the toner density in the printer. The
range of values is from 1 (low) to 10 (high).
NOTE: Toner Density is not available when connected to an inkjet printer or to a
Xerox 6030/6050 Wide Format printer.
2. Printer Language - Click on this list box to select the language used by the Web
PMT, the X2 printer’s front panel interface, and Test Print pages. You must select from
the languages that are installed on the printer. The Web PMT will show the new
language when you switch to a new Web PMT page.
3. Error Page - Click on this list box to select the printer error page specification. Error
pages will be generated for process errors, not media-handling errors. The choices are
NONE, LEVEL1 (serious errors only), and LEVEL2 (all errors and warnings).
4. Active User Setup - this text box is used to specify any one of 10 parameter sets to
use as the default processing parameters. The default va lue is set 0. Valid input range
is from 1 to 9.
5. Single Page Job - With this feature, the printer will attempt to sequentially print
adjacent pages in a job that are the same width to produce a single long copy for the
job. Setting the feature to one of the roll sizes will override each page's media
selection, ensuring that the job will successfully print on a single page. If a page's
media width or type differs from the previous page, or if the maximum printer length
has been reached, the printer will cut the job between pages. Setting the feature to
Enabled means that normal AccXES processing will be used to select media. The
default for this feature is Disabled.
This feature can be used with Plot Nesting to produce a matrix of images on a single
sheet of media.
6. Banner Page - Click on the Enabled check box to enable/disable the banner page.
When checked, a anner page will be printed for each print job. Click on the list box to
the right to select BEFORE JOB or AFTER JOB to specify where the banner page
should be printed.
7. Diagnostic Page - Click on this box to enable/disable diagnostic pages. If this box is
checked, a diagnostics page is generated after every page printed.
8. DDS Enabled - This selection box allows configuration of the AccXES Controller for
use in a DDS system. When the DDS Enabled box is checked, the AccXES Controller
will configure itself for use with a scanner. When the DDS Enabled box is not checked
the AccXES Controller will configure itself for use as a Printer only. The controller must
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be rebooted after selecting/deselecting the DDS Enabled box before the change will
take effect.
9. Area Media Usage -This field reports the total area of media printed by the printer.
This parameter is only displayed for the 8830, 8825, 8850, 510DP, and 721P printers.
You cannot set this parameter.
10. Linear Media Usage - This field reports the total length of media printed by the printer.
You cannot set this parameter.
11. Plot Nesting
Ÿ

Enabled - Click on this check box to enable/disable the nesting of plots from one or
more print jobs.
Ÿ Exclusive - When this check box is selected, the printer will start a new plot nest
for each print job (i.e., plots from two or more jobs will not be placed on the same
output page).
Ÿ Timeout - Enter the maximum idle time in seconds after processing a print job
before printing an incomplete nested output page.
Ÿ Margins - Enter the printer-imposed margin spacing between plots in a nested
output page.
Ÿ Nesting Length - Enter the maximum length of a nest. If a plot to be placed in a
nest exceeds this length, the nest will be terminated and the plot will be printed
separately.
12. Press the Update Printer button to update the specified parameter changes in the
printer.

Pen Palettes Page
Navigation: PRINTER DEFAULTS > PRINTER SETUP > Pen Palettes
You can use this page to view or change (if you entered the printer password) the Pen
Palettes stored in the printer. The pen palette settings apply to the following file formats
(vector graphic languages): HPGL, CalComp, VDS and CGM. Any one of the 9 Pen Palettes
can be displayed or downloaded from the printer. Palette 0 is read only. Pen Palettes 1
through 8 can be changed or uploaded to the printer. The Pen Palette Table displays the Pen
Number and corresponding Pen Attributes for the 256 pens in a palette.
1. To display a different palette, click on the Palette Name list box to select a specific
Pen Palette (select a number from 0 to 8). Press the Display Palette button and the
Pen Palette Table will be updated to display the selected palette.
2. To save or load the currently selected palette, click on palette name link at the top of
the palette table (e.g., click on Palette #1) to display the Pen Palette Options page.
This page is used to save or load a Pen Palette (if you entered the printer password on
the Session Setup page).
Ÿ To save the selected Pen Palette to a file, press the Save Palette button and the
Save Palette File dialog will display. Enter the directory and file name in the Save
As file dialog. Press the OK button and the selected Pen Palette will be saved in
the specified file. You will be returned to the Pen Palette Options page. To return to
the Pen Palettes page, press the browser Back button.
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Ÿ

To upload a pen palette file to the selected Pen Palette, press the Load Palette
button (this button is displayed only for palettes 1 through 8) and the Load Palette
File page will display. On the Load Palette File page, enter the full file path name of
the desired pen palette file in the indicated text box. To help select a file, press the
Browse... button to display the standard file dialog. Once you have selected a valid
pen palette file, press the Update Printer button. A message page will display
stating the success or failure of the request. To return to the Pen Palettes page,
click on the BACK TO Palette link on the message page.

3. To change the attributes of a pen for the currently selected palette (for a palette in the
range 1 through 8), click the desired pen number (the hypertext link in the first column
of the Pen Palette table) to display the Pen Attributes page. This page is used to
change the attributes of the selected pen. If you entered the printer password, you can
use this page to change and copy to other pens the attributes of the selected pen. The
Pen Attributes table lists four attributes b y name (hypertext link), Current value and
New value (the New value will be updated as you make your changes).
Ÿ Click on the desired attribute name to link to the Change Pen attribute page for that
attribute (e.g., click on Width to display the Change Pen Width page).
Ÿ If you selected Width , enter the desired width in the corresponding text field
and click on the mm or in. radio button to select the units.
Ÿ If you selected Pattern, click on the radio button next to the desired pen
pattern.
Ÿ If you selected Color, click on the radio button next to the desired pen color or
enter the red, green, blue color values (RGB color code) in the corresponding
text fields at the top of the color table. The range of values for red, green, and
blue is 0 to 255.
NOTE: If your printer does not support color, the RGB value is converted to a
gray scale value.
Ÿ If you selected Override, click on the desired override check boxes.
Ÿ

Ÿ

Ÿ

Ÿ

Press the OK button (on the Change page). The Pen Attributes page will display
and the changed pen attribute will update the previous value shown under the New
column heading.
Repeat steps 1 and 2 for any other pen attribute you wish to change. After you
have completed the changes to the pen attributes, proceed to the Pen Copy
options below.
On the Pen Attributes page, select the pen attributes that you wish to copy to one
or more other pens in this palette. On the Pen Copy line, click on any of the
following check boxes: Width , Pattern, Color and Override.
In the Copy to pen(s) text box, enter the pen number or numbers.

Ÿ

Press the Update Printer button to change the pen attributes to the settings shown
in the New column of the Pen Attributes table for the selected pen and any copied
to pens. This only changes the currently selected palette in the printer.
4. Click on the BACK TO Palette link to return to the Pen Palettes page.
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Pen Patterns Page
Navigation: PRINTER DEFAULTS > PRINTER SETUP > Pen Patterns
This page displays the printer's 64 pen patterns:
Ÿ 50 read-only pen patterns (including a "no pattern"), numbered 0 through 49
Ÿ 14 user-defined patterns, numbered 50 to 63
1. Click on a specific pen pattern (image link) to display the Pen Pattern Options page,
which is used to save or load (for patterns in the range 50-63) the selected pen
pattern. You can use this page to save or upload (if you entered the printer password)
a Pen Pattern.
Ÿ To save the selected Pen Pattern to a file, press the Save Pattern button and the
Save Pattern File dialog will display. Enter the directory and file name in the Save
As file dialog. Press the OK button and the selected Pen Pattern will be saved in
the specified file. You will be returned to the Pen Pattern Options page. To return to
the Pen Patterns page, press the browser Back button.
NOTE: When using Internet Explorer on Windows NT, depending upon the
association of programs with certain file types, it is possible for a program, such as
Microsoft Paint, to open in place of the "save to file" dialog. If this occurs, perform
the following steps.
Ÿ Open the Options dialog from the View Menu of "My Computer."
Ÿ Select the File types tab of the Options dialog.
Ÿ Select bitmap on the registered file types list and click the Edit button.
Ÿ
Ÿ

On the Edit dialog, place a checkmark in the "Confirm open after download"
checkbox.
Click OK on the Edit and Options dialogs.

Ÿ

To upload a pen pattern file to the selected Pen Pattern (in the 50 to 63 range),
press the Load New Pattern button and the Load New Pattern File page will
display. On the Load page, enter the full file path name of the desired pen pattern
file in the indicated text box. To help select a file, press the Browse... button to
display the standard file dialog. Once you have selected a valid pen pattern file,
press the Update Printer button. A message page will display stating the success
or failure of the request.
2. To return to the Pen Patterns page, click on the BACK TO Pen Patterns link on the
message page.
NOTE: You may need to press the browser Refresh (or Reload) button to update the
display of the Pen Patterns.
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Plot Labels Page
Navigation: PRINTER DEFAULTS > PRINTER SETUP > Plot Labels
If you entered the printer password in the Session Setup, you can change the default plot
label parameters in the printer as follows:
1. Plot labels can be specified by selecting any one of the three label options. These
are:
Ÿ No Label - No plot label will be printed.
Ÿ Default Label - This will attempt to stamp the plot with Job Name/Date/Time.
Ÿ Label - This will print the text entered in the text box.
The label is limited to 255 characters. Do not use the characters "=" or "&" in your
label text as this will cause subsequent characters to be missing in your Label. The
label may contain embedded formatting characters directing the printer to insert
various types of data into the label (e.g., %d means insert the date).
The formatting codes are:
%d (date)
%n (job name)
%f (file name)
%% (percent sign)
%p (page number)
%c (new line)
%t (time of day)
2. Click on the Font drop list to select a font for the label.
3. Click on the X Position and Y Position radio buttons to select Relative or Absolute
positioning of the plot label. If Relative is selected, click on the corresponding drop list
to select one of the listed positions. If Absolute is selected, enter the distance in the
corresponding text box on the same line.
There is one special restriction: If you clicked on Relative for the X coordinate and you
selected EXTEND from the drop list, you must click on the Absolute radio button for
the Y position and enter a distance in the text box on the Y Position line. In this case,
the plot label will be placed beyond the image plot by the amount specified in the Y
Position text box (the label is "extended" beyond the plot by the indicated amount).
The Y Position of the label will be along the Bottom.
4. The default printer plot label can be rotated relative to the plot image. Enter the
rotation angle (0 to 359) in the Rotation text box.
5. Enter the font point size (6 to 72) of the label in the Size text box.
6. Enter the percentage of shading (on a gray-scale) in the Shading text box. 0 is for no
shading and 100 is for all black.
NOTE: "Server Error - 503" may be displayed if your Label Text exceeds 255
characters in length. To remedy this situation, reduce your label text length to no
more than 255 characters.
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7. Press the Update Printer button to update the default plot label parameters in the
printer.

Fonts Page
Navigation: PRINTER DEFAULTS > PRINTER SETUP > Fonts
This read-only page displays the font names contained in the printer.
Index

Stamps Page
Navigation: PRINTER DEFAULTS > PRINTER SETUP > Stamps
Use this page to view or change (if you entered the printer password) the printer's default
stamp parameters (if any) and the Printer Resident Stamps.
1. Press the Load Stamp button and the Load Stamp File page will display. This page
is used to add a stamp to the Printer Resident Stamps list.
Ÿ

Ÿ
Ÿ

On the Load Stamp File page, enter the name of the stamp file in the designated
text box. To help select a file, press the Browse... button to display the standard
file dialog.
Press the Update Printer button. A message page will display stating the success
or failure of the request.
To return to the Stamps page, click on the BACK TO Stamps link on the message
page. The uploaded stamp will appear on the Printer Resident Stamps list.

NOTE: You may need to press the browser Refresh (or Reload) button to updated
the display of the Stamps page if you have loaded a new stamp or set the printer's
default stamp.
2. Click on a stamp name (hypertext link) in the Printer Resident Stamp list and the
Stamp Options page will display. After pressing one of the following buttons on the
Stamp Options page, the Stamps page will display:
Ÿ Press the Delete Stamp button to delete the selected stamp from the Printer
Resident Stamp list.
Ÿ Press the Default Stamp butto n to make the selected stamp the default stamp in
the printer (the Name field on the Stamps page will be updated).
Ÿ Press the No Stamps button to clear the printer's default stamp (No Stamps will
display in the Name field on the Stamps page). The selected stamp is not removed
from the Printer Resident Stamps.
3. To position and scale the default stamp (if the Name field display is No Stamps, go to
step 2 to first select a default stamp):
Ÿ Click on the X Position and Y Position radio buttons to select Relative or
Absolute positioning of the stamp on the output page. If Relative is selected, click
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Ÿ
Ÿ
Ÿ

on the corresponding drop list to select one of the listed positions. If Absolute is
selected, enter the distance in the corresponding text box on the same line.
Click on the Rotation list box to select the rotation of the stamp relative to the plot
image.
Click on the Scaling drop list to select Relative or Absolute scaling. Enter the
scaling percentage (0 to 100) in the text box to the right.
Press the Update Printer button to update the default stamp parameters in the
printer.

Date/Time Page
Navigation: PRINTER DEFAULTS > PRINTER SETUP > Date/Time
1. This page will set the date, time, and date format in the printer. Drop lists are provided
for month, day, year, hour, minute, second, and date format.
2. Imperial (MM/DD/YYYY) and International (DD/MM/YYYY) date formats are available.
With Error/Warning pages, Diagnostic pages, Banner pages, and Labels, the date is
displayed in the selected date format.
3. Press the Update Printer button. A message page will display stating the success or
failure of the request.

Power Saver Page (8855 only)
Navigation: PRINTER DEFAULTS > PRINTER SETUP > Power Saver
This page will set the sleep modes and warm-up time of the printer.
1. Power Saver to Rest Delay Specify the rest delay in minutes by entering the value
into the text box.
2. Ready to Power Saver Delay Specify the power saver delay in minutes by entering
the value into the text box.
3. Press the Update Printer button. A message page will display stating the success or
failure of the request.
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Emulations Menu
HPGL Page
Navigation: PRINTER DEFAULTS > EMULATIONS > HPGL
If you entered the printer password in the Session Setup, you can change the following HPGL
parameters in the printer:
1. HPGL Mode - Click on this list box to select HPGL_758X or HPGL/2. When the data in
the plot file is ambiguous, the printer will assume the file is in the selected format.
2. HP RTL Resolution - This is used as the default resolution for HP-RTL CAP position
and raster scaling. The range is 300 to 1200 (default is 300).
3. NP - This setting is used to define the default number of pens. Valid settings are from
2 to 256. This is only needed for legacy files which use more than the default 8 pens,
but don't specify how many via the NP command. If a file attempts to use a pen
beyond the specified Number of Pens (NP) a modulo operation will be used to select a
valid pen (pen_used = pen_requested mod NP).
4. Assigned Palette - Click on this list box to select the default pen palette (0 to 8) for
HPGL plots.
5. Job overrides assigned pen palette - Click on this check box to enable/disable the
override option. If this box is checked, any pen settings in the HPGL plot file will
override the assigned default pen palette. If this box is not checked, the assigned
default pen palette will be the source for the attributes of all pens used in plotting. The
only exception is for individual pens using the override setting of the Pen Attributes
page, accessed by clicking a pen number on the Pen Palettes Page of the Printer
Defaults Side Menu.
6. Merge Control Default - The Merge Control feature determines how the pixels of
intersecting lines or graphics will be shown in the printed job. With this box
unchecked (default), one line or graphic will overwrite the other. With the Merge
Control checked to 'ON', a merge color (i.e. halftone) will be created at the intersection
of the vectors (i.e. lines or graphics).
7. Reinitialize after EOF -If print files are streamed via any port on the system, these are
treated as a single job and no reset is done between them. However, if one uses the
LPD protocol to send print files one at a time, the effect is that the printer is reset after
each job. If the "Reinitialize after EOF" is set to be on, the firmware will reset the
printing parameters after each plot file that is received by a serial port or a parallel
port.
8. Ignore PS command – Click on this check box for HP-GL DFI to ignore the Page Size
(PS)command. This can be useful when printing certain defective files (i.e.,
incompatible with HP-750C printers).
9. Force round line ends - Click on this check box to cause the HP-GL DFI to print lines
with round ends and round joints. (This will initialize the line cap style to round ends
and to set the line join style to “none”, and the HP-GL/2 Line Attributes (LA) command
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will be ignored.) This can be useful when printing certain defective files (i.e.,
incompatible with HP-750C printers).
10. Termination Conditions - Click on this group of check boxes to enable/disable which
HPGL commands will cause a plot to be terminated (completed). The available check
boxes are AF, AH , FR , NR , PG , RP, SP, and Plotter Off.
11. Press the Update Printer button to update the specified parameter changes in the
printer.

Calcomp 906/907 Page
Navigation: PRINTER DEFAULTS > EMULATIONS > Calcomp 906/907
If you entered the printer password in the Session Setup, you can change the following
CalComp 906/907 parameters in the printer:
1. Step Size (resolution) - Enter the CalComp plotter step size (resolution) in this text
box. Most CalComp plot files use a step size of 2032. The range is from 50 to 4064.
2. Assigned Palette - Click on this list box to select the default pen palette (0 to 8) for
CalComp plots.
3. Job overrides assigned pen palette - Click on this check box to enable/disable the
override option. If this box is checked, any pen settings in the CalComp plot file will
override the assigned default pen palette. If this box is not checked, the assigned
default pen palette will be the source for the attributes of all pens used in CalComp
plots. The only exception is for individual pens using the override setting of the Pen
Attributes Page, accessed by clicking a pen number on the Pen Palettes Page of the
Printer Defaults Side Menu.
4. Message Format - This group of parameters modifies how the CalComp 906/907
interpreter works. The printer will automatically determine the correct values for the
three numerical parameters if they are not set correctly.
Ÿ EOM Character - This text box is used to set an EOM character to a decimal
value. Enter a number between 0 and 31.
Ÿ SYNC Character AH - This text box is used to set a SYNC character to a decimal
value. Enter a number between 0 and 127.
Ÿ Number of SYNC Chars - Click on this list box to select 1 or 2 as the number of
SYNC characters expected in the CalComp jobs sent to the printer.
Ÿ Checksum Enable - Click on this check box to enable/disable the CalComp
interpreter to utilize the checksum in the CalComp 906/907 data message blocks.
5. Termination Conditions - Click on this group of check boxes to enable/disable which
CalComp commands will cause a plot to be terminated (completed). For Search
Address termination, you can enable either 999 or 9999 or both. When the EOP box is
checked, click on the list box to select 1 or 2 as the number of EOP commands in the
plot termination sequence. The other available check boxes are Manual, New Plot,
Pause, Force Plot, Start Plot and Top of Form.
6. Press the Update Printer button to update the specified parameter changes in the
printer.
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Versatec Raster Page
Navigation: PRINTER DEFAULTS >EMULATIONS > Versatec Raster
If you entered the printer password in the Session Setup, you can change the following
Versatec Raster plot parameters in the printer:
1. Versatec Character Encoding - Click on this list box to select how the Versatec
emulation interprets Print Mode data. You can select ASCII or EBCDIC encoding.
2. Versatec Raster Device Emulation - Click on this list box to select a legacy Versatec
device as the default device emulation.
3. Custom Settings -The Custom Settings group will be ignored unless the Raster
Device Emulation list box is set to CUSTOM. This group is used to make custom
raster device changes to three parameters:
Ÿ Characters per Line - Enter the number (10 to 999) of ASCII print mode
characters per line.
Ÿ Resolution - Click on this list box to select 100, 200, 300 or 400 for the number of
pixels per inch.
Ÿ Bytes per Line - Enter the number (10 to 999) of bytes of plot mode raster data
per line.
4. Press the Update Printer button to update the specified parameter changes in the
printer.

VDS Page
Navigation: PRINTER DEFAULTS > EMULATIONS > VDS
If you entered the printer password in the Session Setup, you can change the following
default VDS plot parameters in the printer:
1. Versatec Character Encoding - Click on this list box to select how the Versatec
emulation interprets Print Mode data. You can select ASCII or EBCDIC encoding.
2. Assigned Palette - Click on this list box to select the default pen palette (0 to 8) for
VDS plots.
3. Job overrides assigned pen palette - Click on this check box to enable/disable the
override option. If this box is checked, any pen settings in the VRF plot file will override
the assigned default pen palette. If this box is not checked, the assigned default pen
palette will be the source for attributes of all pens used in VDS plots. The only
exception is for individual pens using the override setting of the Pen Attributes page,
accessed by clicking a pen number on the Pen Palettes Page of the Printer Defaults
Side Menu.
4. Press the Update Printer button to update the specified parameter changes in the
printer.
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CGM Page
Navigation: PRINTER DEFAULTS > EMULATIONS > CGM
If you entered the printer password in the Session Setup, you can change the following
default CGM p lot parameters in the printer:
1. Default Media - Click on this list box to view and select the default media size
expected by CGM. The default media size is used when CGM absolute scaling is
performed.
2. Background Color - Click on this list box to select CGM color management. Select
FILE CONTROL (the CGM file dictates background color) or FORCE BLACK ON
WHITE (background is forced to be white with drawing in black).
3. Assigned Palette - Click on this list box to select the default pen palette (0 to 8) for
CGM plots.
4. Job overrides assigned pen palette - Click on this check box to enable/disable the
override option. If this box is checked, any pen settings in the CGM plot file will
override the assigned default pen palette. If this box is not checked, the assigned
default pen palette will be the source for the attributes of all pens used in CGM plots.
The sole exception is for individual pens using the override setting of the Pen
Attributes page, accessed by clicking a pen number on the Pen Palettes Page of the
Printer Defaults Side Menu.
5. Press the Update Printer button to update the specified parameter changes in the
printer.

VCGL Page
Navigation: PRINTER DEFAULTS > EMULATIONS > VCGL
If you entered the printer password in the Session Setup, you can change the following
default VCGL parameters in the printer:
1. Resolution - Click on this list box to select the resolution
2. Background Color - Click on this list box to select VCGL color management. Select
FILE CONTROL (the VCGL file dictates background color) or FORCE BLACK ON
WHITE (background is forced to be white with drawing in black).
3. Assigned Palette - Click on this list box to select the default pen palette (0 to 8) for
VCGL plots.
4. Job overrides assigned pen palette - Click on this check box to enable/disable the
override option. If this box is checked, any pen settings in the VCGL plot file will
override the assigned default pen palette. If this box is not checked, the assigned
default pen palette will be the source for the attributes of all pens used in VCGL plots.
The sole exception is for individual pens using the override setting of the Pen
Attributes page, accessed by clicking a pen number on the Pen Palettes Page of the
Printer Defaults Side Menu.
5. Press the Update Printer button to update the specified parameter changes in the
printer.
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TIFF Page
Navigation: PRINTER DEFAULTS > EMULATIONS > TIFF
If you entered the printer password in the Session Setup, you can change the following
default TIFF plot parameters in the printer:
1. 1 Bit Photo - Click on this list box to select FILE CONTROL or IGNORE MIN=BLACK.
2. Press the Update Printer button to update the specified parameter changes in the
printer.

PostScript Page
Navigation: PRINTER DEFAULTS > EMULATIONS > PostScript
If you entered the printer password in the Session Setup, you can change the following
default PostScript plot parameter in the printer:
1. Default Media - Click on this list box to view and select the default media size
expected by PostScript.
2. Postscript Halftone Method (for Color Printers only) - Click o n this list box to select
Halftone Screening or Error Diffusion.
Halftone Screen renders images with a standard printing press appearance. This is
the factory default setting.
Error Diffusion renders images with more of a continuous tone (photographic
appearance). Note that error diffused images, which are computationally intensive,
take considerably longer to process.
3. EPS Enabled – Select the checkbox to enable the PostScript interpreter in to search
for and handle the Encapsulated PostScript (EPS) commands when processing the
file.
4. Use CIE Color - If a color printer is attached, selecting this feature will produce vibrant
colors for Auto or Graphic document types. For Lines and Text document types, the
colors will look more saturated (bold). For Photo document types, the colors will look
truer to the original photograph. ("Document Type" is selected on the Processing
Default > Rendering screen.) This feature works by converting incoming color
information to CIE color, then back to CMYK or Gray through a Color Rendering
dictionary.
5. PDF Optimization - This feature is selected by default to control some "behind the
scenes" processing inside the PostScript rendering path. If you have problems printing
a PDF file, unselect this feature to see if it fixes the issue.
6. Press the Update Printer button to update the specified parameter in the printer.
NOTE: This option requires a PostScript license.
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Processing Defaults Menus
Finishing Page
This description applies to the Xerox WIDE FORMAT 8830 folder.
Navigation: PRINTER DEFAULTS > PROCESSING DEFAULTS > Finishing
Folder Type - This read-only field displays the type of folder currently connected to the
printer. The Web PMT automatically detects the type of folder installed on the printer.
If you entered the printer password in the Session Setup, you can change the following
printer defaults for finishing:
1. Folding Options - Click on this list box to select the printer default folding operation.
The list box will display all the folding options. You must select a va lid folding option for
your folder type (the default is NO FOLD).
2. Press the Update Printer button to update the specified parameter changes in the
printer.
This description applies to any GFI folder.
Navigation: PRINTER DEFAULTS > PROCESSING DEFAULTS > Finishing
Finisher Version - This read-only field displays the version of the folder currently connected
to the printer.
Finisher Model - This read-only field displays the model of the folder currently connected to
the printer.
If you entered the printer password in the Session Setup, you can change the following
printer defaults for finishing:
1. Programs - Click on this drop box to select from a list of the available finisher
programs. Directly below the Programs list is a more detailed description of the
currently selected program. Please note that the program description will not change
on the WebPMT page until the Update Printer button has been pressed.
2. Tabs - Click on this drop box to select from a list of the available tab override settings.
Available options are Always On, Always Off, USE PROGRAM SETTING. Default is
USE PROGRAM SETTING
3. Punch - Click on this drop box to select from a list of the available punch override
settings. Available options are Always On, Always Off, USE PROGRAM SETTING.
Default is USE PROGRAM SETTING
4. Margins - Click on this drop box to select from a list of the available margin override
settings. Available options are Always Off, USE PROGRAM SETTING. Default is USE
PROGRAM SETTING
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5. Crossfold - Click on this drop box to select from a list of the available crossfold
override settings. Available options are Always On, Always Off, USE PROGRAM
SETTING. Default is USE PROGRAM SETTING
6. Title Block Location - Click on this drop box to select from a list of the available title
block override settings. Available options are Don't Care, Upper Left, Upper Right,
Lower Left, Lower Right. Default is Don't Care
7. Output Bin - Click on this drop box to select from a list of the available output bin
override settings. Available options are Don't Care, Bin 1 through Bin 13, Fanfold,
Bypass. Default is Don't Care.
8. Intelligent title block –
For folding documents with title blocks in standard corners: If you selected an incorrect
title block location for the fold style, checking the Intelligent Title Block box will adjust
the location of the title block for proper folding.
For folding documents with title blocks that are not in an expected standard corner:
Leave the Intelligent Title Block box unchecked.
9. Press the Update Printer button to update the specified parameter changes in the
printer.

Justification Page
Navigation: PRINTER DEFAULTS > PROCESSING DEFAULTS > Justification
If you entered the printer password in the Session Setup, you can change the default printer
parameters for justification in the X and Y directions as follows:
1. Using the Absolute and Relative radio buttons, you may independently specify X and
Y justification in absolute dimensions or relatively.
Ÿ X - the left margin position of the printed image on the page.
Ÿ

Y - specifies the top margin position of the printed image on the page.

Ÿ

Relative - Click on this radio button to select relative justification for either X or Y. If
Relative is selected for either X or Y, click on the corresponding list box to select
the one of the relative values.
Ÿ Absolute - Click on this radio button to select absolute dimensions for either X or
Y. If Absolute is selected for either X or Y, in the corresponding text box enter the
desired value (0 to 2540 mm, or 0.0 to 100.0 inches). The units for absolute
dimensions are specified on the Set Display Units page of the UTILITIES group of
the Printer Defaults Side Menu.
2. Press the Update Printer button to update the default justification parameters in the
printer.

Margins Page
Navigation: PRINTER DEFAULTS > PROCESSING DEFAULTS > Margins
If you entered the printer password in the Session Setup, you can change the printer default
margins as follows:
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1. Four margins may be set independently: Left, Top, Bottom and Right. Enter the
desired margins (0 to 2540 mm, or 0.0 to 100.0 inches) in the corresponding text
boxes.
2. Press the Update Printer button to update the default margins in the printer.

Media Page
Navigation: PRINTER DEFAULTS > PROCESSING DEFAULTS > Media

Media Defaults
If you entered the printer password in the Session Setup, you can change the following
default media parameters in the printer:
1. Media Size - Click on this list box to select the printer default paper size. Jobs
received by the printer without a specified paper size are printed on this media size. If
Auto scaling is enabled on the Transform page, the following paper sizes are not
allowed: ANY, ANY ANSI, ANY ISO, ANY JIS, and ANY ARCH.
2. Media Type - Click on this list box to select the printer default media type. Jobs
received by the printer without a specified media type are printed on this media type.
3. Media Source - Click on this list box to select the source of the media from the
available sources of media in the printer. The AUTO selection will allow the printer to
automatically select the correct media source. The choices are: ROLL 1, ROLL 2,
ROLL 3, ROLL 4, MANUAL FEED, and AUTO. (The roll choices are dependent on the
type of printer).
4. Media Size Detect - Click on this list box to set the method the printer will use to
detect the size of the media required to hold the printed image. The choices are PLOT
SPECIFIED or DRAWN AREA.
PLOT SPECIFIED - If the job data contains an embedded command explicitly
requesting a particular page size (e.g., the PS command in HPGL/2), the job data will
be used to determine the size of the page on which the image will be drawn.
DRAWN AREA - The AccXES Controller will determine the page size required,
based upon the bounding box of the drawn image.
5. Collation - Click on the Collation list box to select Off or On.
6. Copies - Enter the printer's default number of copies (1 to 999) in this text box.
7. Oversize Margin - When Media Size is set to ANY, ANY ANSI, ANY ARCH, or ANY
ISO, this parameter determines the percentage of image oversizing that will be
allowed before selecti ng a larger, installed media size, of the same type, to fit the
printed image on. The range is 0 to 100%, with a factory default setting of 1%.
8. Undersize Margin - When Media Size is set to ANY, ANY ANSI, ANY ARCH, or ANY
ISO, this parameter determines the percentage of image undersizing that will be
allowed before selecting a smaller, installed media size, of the same type, to fit the
printed image on. The range is 0 to 100%, with a factory default setting of 2%.
9. Maximum Plot length - In this text box, enter the maximum length that the printer will
plot. On the WIDE FORMAT PRINT SYSTEM 8830/8825/8850/ 510DP, the range is
from 121.92 cm to 2438.40 cm, or from 48 inches to 960 inches. The maximum length
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on the WIDE FORMAT PRINT SYSTEM 8855 is 1600.2 cm or 630 inches. The
maximum length on the WIDE FORMAT PRINT SYSTEM 721P is 2400 cm or 945
inches.
10. Mismatch Queue - Click on this check box to enable/disable mismatch queuing.
When a media mismatch occurs, and this box is not checked, the Status column of the
Job Queue List will display Mismatch/Blocked, and printing will pause until the
necessary medium is installed or the job is cancelled. When a media mismatch occurs,
and this box is checked, the Status column of the Job Queue list will display
Mismatch/Queued. In this case, pages requiring the missing medium are not printed,
but pages requiring media which are currently installed will be printed.
11. Press the Update Printer button to update the default media parameters in the printer.

Media Mismatch Mode
1. Select PRINTER DEFAULTS > PROCESSING DEFAULTS > Media to display the
Media page.
2. Click on the Media Specific Settings list box to select a media type.
3. Press the Adjust Settings (Text Form), or Adjust Settings (Graphical UI) button to
go to the Media Specific Settings page.
4. Media Mismatch Mode - Select the QUERY mode if you want the printer to prompt
the operator at the printer control panel to install the appropriate media size. For
monochrome printers, select the SUBSTITUTE mode if you want the printer to make
media type substitutions as necessary to print the page. Select the SCALING mode if
you want the printer to automatically scale to the nearest available media size of the
same media type.
5. Press the Update Printer button.

Media Color Settings (only for color inkjet printers)
Media Color Settings can be adjusted for you to get your expected printed color.
Ink Limit is used to change the maximum amount of ink used in printing. Valid values for
Ink Limit are 1% to 100%.
Gamma is used to adjust the entire color curve without moving the endpoints of the curve.
This adjusts the mid tones (higher gamma produces darker mid tones), with minimal effect
on shadows and highlights. Valid values for Output Gamma are 0.5 to 2.2.
1. On the Media Page, select the media type in the Media Specific Settings section.
If you have a Java plug-in installed
(http://java.sun.com/products/archive/j2se/1.4.0/index.html), or if you have permissions to
install it for your browser, then select the Adjust Settings (Graphical UI) button. If not,
press the Adjust Settings (Text Form) button. If you did not have the Java plug-in
installed and you selected the Graphical UI, then it will attempt to install itself (it gets
downloaded from the Sun web site, so you will need internet access for this). You should
follow the instructions on-screen in order to install the plug-in.
2. If you are on the Media Specific Settings Graphical UI page, do the following. If you are
on the Text Form page, go to the next section.
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Ÿ

For the Media Type listed at the top of the page, select the “Document Type” and
“Raster Halftone Method” from the drop down menus.

Ÿ

Press the Get Settings button. This will show the current settings for the selected
media type, document type, and raster halftone method.

Ÿ

Select the Cyan, Magenta, Yellow, or Black radio button. Click and drag the colored
dots vertically on the graph line for the specified media type and document type. The
Input and Output Values will show under the graph. Repeat for each color. Note that
modifying the color curves in this way only changes the colors for the currently
selected document type.

Ÿ

Move the sliding gamma and ink limit arrows to adjust the color settings for the
currently selected color curve. Note that this will modify the Gamma and Ink Limit for
all of the document types, not just the selected one.

Ÿ

Pressing the Undo button will remove the changes that were made since the last time
that the Update Printer button was pressed.

Ÿ

Pressing the Redo button will put back the settings as they were before the Undo
button was pressed.
Note that multiple-level Undo and Redo is supported and that pressing the Update
Printer button will clear out the Redo buffer.

•

Pressing the Reset Factory TRCs button will put back the TRC curves for the
specified Media Type and Document Type to their factory default values.

•

Press the Update Printer button to send the new values to the printer.

3. If you are on the Media Specific Settings Text Form page, do the following:
Ÿ

For the Media Type listed at the top of the page, select the “Document Type” and
“Raster Halftone Method” from the drop down menus.

Ÿ

Press the Get Settings button. This will show the current settings for the
selected media type, raster halftone method, and the selected document type.

Ÿ

Manually type in the color curve values to adjust the color curves for the selected
media type and document type. Note that the values that are entered will be further
adjusted by the gamma and ink limit, so if you want to directly modify the input/output
you should set gamma to 1.0 and ink limit to 100%.

Ÿ

Pressing the Reset Page button will reset to the values before you edited this table.

Ÿ

Pressing the Reset Factory TRCs button will put back the TRC curves for the
specified Media Type and Document Type to their factory default values.

Ÿ

Press the Update Printer button to send the new values to the printer.
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Transform Page
Navigation: PRINTER DEFAULTS > PROCESSING DEFAULTS > Transform
If you entered the printer password in the Session Setup, you can change the following
printer default settings for scaling, rotation, mirroring and raster image scale mode:
1. Scaling - Click on the Auto or Absolute radio button to select the type of Scaling.
Ÿ

If Auto is selected, the printer will automatically scale the image to the requested
media size. Auto scaling is not allowed for the following paper sizes: ANY, ANY
ANSI, ANY ISO, ANY JIS and ANY ARCH.
Ÿ If Absolute is selected, enter the desired scaling percentage (10 to 999) in the
corresponding text field and the image will be scaled by this percentage. A value of
100 % corresponds to 1:1 scaling.
2. Rotation - Click on the Auto or Fixed radio button to select the Rotation option.
Ÿ

If Auto is selected, the printer will determine the most economical rotation for the
document pages.
Ÿ If Fixed is selected, click on the list box to the right to select 0, 90, 180 or 270
degrees for the rotation.
3. Mirror Image - Click on the appropriate check box or boxes to select the mirror
imaging for the plot. You can leave both X and Y unchecked, check either X or Y, or
check both X and Y. When checked, the image will be mirrored in that direction.
4. Raster Image Scale Mode - Click on the Photo or Line radio button to select the
method used when raster images are scaled down. If Photo is selected, a simple
pixel-depleting algorithm will be used. If Line is selected, a pixel-preserving algorithm
will be used.
5. Line Scale Mode - Select the “On” radio button to scale the line (pen) widths along
with the rest of the drawing.
6. Press the Update Printer button to update the default transform parameters in the
printer.
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Rendering Page
Navigation: PRINTER DEFAULTS > PROCESSING DEFAULTS > Rendering
1. Render Mode - Click on this list box to set the Render Mode for color printers to color
or grayscale. For monochrome printers, grayscale is the only valid option.
2. Print Quality Mode - In general, the more bi-directional passes that the printer makes
to create the image, the higher quality the output will be, but the longer it will take to
produce it. The FAST selection is a single pass bi-directional printing using RACER
Technology, NORMAL is 2 -pass bi-directional printing, and BEST is 4-pass bidirectional printing.
3. Document Type - Click on this list box to set the Document Type to autoselect,
graphics, photo, or lines & text.
4. Contrast - Use this list box to adjust the contrast by specifying an integer from -10 to
+10. A value of "0" means that no contrast adjustment is applied. Increasingly negative
values reduce the contrast of the rendered image, while increasingly positive values
increase the contrast of the rendered image.
5. Lightness - Specify the lightness adjustment in this list box. A value of zero means
that no lightness adjustment is applied. Increasingly negative values reduce the
lightness of the rendered image, which darkens the image. Increasingly positive values
increases the lightness of the rendered image, which further lightens the image.
6. Raster Halftone - This parameter allows the selection of the binarization method used
on multibit raster images. The Halftone Screen option offers faster printing than Error
Diffusion, but may produce prints with a grainy appearance. The Error Diffusion setting
generally produces a smoother print image.
7. Vector Halftone - This parameter sets the method to use when processing halftone
images. Select Area Fill for best reproduction of large polygon fills. Select Line
Optimized to accentuate fine lines, especially those drawn in filled areas. The factory
default setting is Area Fill.
8. Fineline Grayscale Rendering - Select either Contone or Black as the parameter to
specify how fine lines should be rendered when the Render Mode is set to Grayscale.
In Grayscale Render Mode, fine lines that are drawn in a light luminance color, such
as yellow, will appear very light if this parameter is set to Contone. Setting this
parameter to Black will cause these lines to appear as black.
9. Fineline Pixel Threshold - This parameter specifies the maximum line width that will
be processed as a fine line. The range is 1 - 25.
10. Vector Minimum Line Width – Use this setting to improve visibility of fine lines.
Depending on your printer’s resolution, lines that are only a few pixels wide may
appear light and/or be difficult to see. This setting allows you to improve visiblility by
setting the minimum width of drawn lines anywhere from 1 (the default) to 10 pixels.
Lines made wider may no longer be considered fine for the Fineline Pixel Threshold
feature (see above). This setting will have no impact if the data being rendered is in
raster format.
11. Press the Update Printer button to update the default rendering parameters in the
printer.
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Accounting Page
Navigation: ACCOUNTING

Introduction
For firmware versions 7.0 and greater, the AccXES Client Tool's Accounting Tool is disabled.
Instead, an External Account Server (EAS)- for example, the AccXES Account Management
Tool (AMT) - will be installed on one computer to track the media usage of many printers. The
AMT Administrator will generate the media usage details for all printed (bond, vellum, film)
media and scanned images. This is done according to the User ID and Account ID that you
specify at the scanner or when using the Document Submit Tool. This information is stored
temporarily on the AccXES Controller's hard drive. The AMT will retrieve the information from
the AccXES Controller. You can, however, see the individual printer's present total number of
stored records by looking on the Web PMT Accounting page, in the Records Count field. If
you are the AMT Administrator, go to the AccXES Account Management Tool User Guide to
learn how to install and use the tool.
Accounting Status - This table reports status information for the following:
1. Machine Name - Displays the name of the machine that was set to uniquely identify the
AccXES Controller. The default value is derived from the AccXES Controllers hardware
network address (MAC). If you entered the printer password in the Session Setup, then
the machine name can be changed.
2. EAS Linked - Set to On when an External Account Server (EAS) has been in contact with
the AccXES Controller, otherwise it is set to Off.
3. Disk Used (%) - Displays the percentage of current use of the AccXES Controller's
available memory in its accounting Job Log file. Note that the use of the Account
Management Tool to download the contents of the Job Log file will purge this memory and
reset this display.
NOTE: When allocated memory has reached its limit an "Error Accounting Disk Full"
message will be displayed in the status line of the Web PMT's Main Page. Use the
Account Management Tool to download the contents of the Job Log file.
4. Records Limit - Displays the maximum number of accounting records allowed to be
stored in the AccXES Controller's Job Log file. This records limit is preserved when
performing a factory default reset.
5. Records Count - Displays the current number of accounting records stored in the
AccXES Controller's Job Log file. Note that the use of the Account Management Tool to
download the contents of the Job Log file will purge the records count and reset this
display to 0. This records count is preserved when performing a factory default reset.
NOTE: When the Records Count has reached its limit an "Error Accounting Record
Limit" message will be displayed in the status line of the Web PMT's Main Page. Use
the Account Management Tool to download the contents of the Job Log file.
Job Accounting Database - This table reports status information for the user and account
information used by the Job Accounting function. The time fields are formatted according to
the setting of the Date / Time configuration when the event occurs. The fields are:
Web Print Manager Tool User Guide

Page 51

1. Database Status Displays the current status of the working database files. The field
will indicate if the working database has been restored from the backup.
2. Time of Restore or Loss This field is displayed only if the "Database Status" field is
other than "Valid". The time indicates the time of restoration from backup.
3. Backup Status Displays the current status of the backup files for the working
database. The Field will indicate if any user or account data has been lost in the
backup process.
4. Time of Backup Status This field is displayed only if the "Backup Status" field is other
than "Not Present". The time indicates the time of the most recent backup of the
working database files.
Accounting Mode If you entered the printer password in the Session Setup, click on one of
the following radio buttons to specify whether account/user ID's are required when sending
print jobs to the printer:
1. Disabled - If this radio button is selected, an account/user ID is not needed to print on
the printer. Media Usage information will not be logged. This mode is the factory
default.
2. Enabled - If this radio button is selected, a valid account/user ID is required to print on
the printer. The Media Usage information will be updated for the account specified by
the print job's account/user ID. Any print job submitted to the printer without a valid
account/user ID is rejected.
3. Optional - If this radio button is selected, an account/user ID is not needed to print on
the printer. If the print job contains an account ID, the Media Usage information will be
updated for the account specified by the print job. If an account/user ID is not
specified, the media usage information will be updated for the generic account.
4. Press the Update Printer button to update the Accounting Mode in the printer.

Job Accounting Error Displays
Effective with Firmware 7.0, if the Accounting Mode of the AccXES Controller has been set to
"Enabled," and you are using the AccXES Account Management Tool (AMT) running on a
networked client workstation, depending upon the condition of the AccXES Controller's Job
Log File, the following messages MAY be displayed in the Device Status Line.
ERROR ACCOUNTING DISK FULL - Printing operations will have halted because the
memory allocated for Job Accounting on the AccXES Controller's hard drive has reached its
limit. The AMT Administrator must use the AccXES Account Management Tool to download
retrieve the data contents of the AccXES Controller's Job Log file.
ERROR ACCOUNTING RECORD LIMIT - Printing operations will have halted because the
total number of Job Records in the AccXES Controller's Job Log file has reached its limit. For
reference purposes, one record is equivalent to one completed job. The AMT Administrator
must use the AccXES Account Management Tool to download retrieve the data contents of
the AccXES Controller's Job Log file.
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WARNING ACCOUNTING DISK FULL - If the AccXES Controller’s Accounting Mode is
disabled, either intentionally using the Account Modes page of the Web PMT, or through an
AccXES Account Management Tool setting, when the Accounting disk is full, account data
logging will cease and this warning will be displayed. The AMT Administrator must use the
Account Management Tool to download retrieve the data contents of the AccXES Controller’s
Job Log file.
WARNING ACCOUNTING RECORD LIMIT - If the AccXES Controller’s Accounting Mode is
disabled, either intentionally using the Account Modes page of the Web PMT, or through an
AccXES Account Management Tool setting, when the total number of records in the AccXES
Controller’s Job Log file has reached its limit, account data logging will cease and this
warning will be displayed. Use the Account Management Tool to download the contents of
the AccXES Controller’s Job Log file.
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Index
Look in the Help Files > Index file to access the hyperlinks to the items in this Index list.
A
About
AccXES Print Server
ACCOUNTING
Accounting Error Displays
ACCOUNTING Mode
AppleTalk
Area Media Usage
Assigned Palette, see CalComp, CGM, HPGL, VDS
Attribute
Auto Scaling
B
Background Color
Banner page
Baud rate
Bindery Mode
C
CalComp
Cancel Print Job
CGM
Change Password
Change Priority
Checksum Enable
Collation
Color- Selecting Color Parameters
Configuration
Configure Remote Printer
Copies
Copy pen
Custom
D
Date Format
Default Media
Default Media, CGM
Default Media, PostScript
Default settings
Default Stamp
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Delete Stamp
DHCP
Diagnostic Page
Disk Used
Display Palette
E
EAS Linked
EMULATIONS
EOM
Error Page
Ethernet
EtherTalk
EtherTalk Phase
EtherTalk Zone
Export
F
Factory settings (default )
Feature Configuration Page
File Format
Fill
Finishing
Fixed Rotation
Folder Type
Folding Options
Fonts
G
Get Status
H
Halftone
Host Port Timeout
HPGL

I
Install Help Files
Image rotation
IP Address
IPX/SPX
IPX Context Name
IPX Frame Type
IPX NDS Tree
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IPX Primary Server
IPX Queue Scan Rate
ISO
J
Job Name
Job overrides assigned pen palette, see CalComp, CGM, HPGL, VDS
Job Priority
Job Queue
Job Status
Justification
L
Label Position
Label Rotation
Labels
Linear Media Usage
Load Palette
Load New Pattern
Load Stamp
M
Machine Name
Main Menu
Main Page
Manual Feed
Margins
Maximum Plot Length
Media
Media Color Calibration
Media Size
Media Size Detect
Media Source
Media Specific Settings
Media Status
Media Type
Media Usage
Message Format
Metrics - see Web PMT Settings
Mirror Image
Miscellaneous
Mismatch Queue
N
NDS Mode
NetBEUI
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NetBEUI Group
NetBEUI Remark
Network
NO FOLD
No Stamp
Novell
NP
O
Override
Oversize Margin
Overview of Web PMT
P
Palette Name
Paper Size
Paper Source
Password
Pen Attributes
Pen Color
Pen number
Pen Override
Pen Palettes
Pen Palette Options
Pen Pattern
Pen Pattern Options
Pen Patterns
Pen Width
Plot Labels
Plot Nesting
PORTS
PostScript
PostScript Test Print
Print job
Printer Language
Printer Name
Printer Password
PRINTER SETUP
Printer Status
Priority
PROCESSING DEFAULTS
Q
Queue
Quick Start
R
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RARP/BOOT
Raster Device Emulation
Raster Image
Records Count
Records Limit
Reinitialize after EOF
Rendering
Reset Error Log
Reset Printer Defaults
Resident Printer Stamps
Resolution
Roll Sizes
Rotation
S
Save Palette
Save Pattern
Scaling
Scaling, Stamps
SCSI
Search Address
Security
Selected Print Job
Serial Port
SESSION SETUP
Shading
Show Active Jobs Only
Side Menu
Single Page Job
Stamp Options
Stamp Position
Stamp Rotation
Stamps
Status
Step Size
Submit
SYNC
System Requirements of Web PMT
T
TCP/IP
Termination Conditions, HPGL
Termination Conditions, Calcomp
TEST PRINT
TIFF
Timeout
Title Block
Toner Density
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Transform
Tutorial – see Quick Sta rt
U
Undersize Margin
Units
Update Job Priority
Upload File
UTILITIES
V
VCGL
VDS
Vector Halftone
Vector Medium Line Width
Versatec
Versatec Raster
Version
VPI
W
Web PMT Settings
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